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The Apache Software License, Version 1.1

Copyright (c) 2000 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software
developed by the Apache Software Foundation (http://www.apache.org/)."

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The names "Apache" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior
written permission. For written permission, please contact apache@apache.org.

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the
Apache Software Foundation.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Autonomy

Copyright ©1996-2000 Autonomy, Inc.

Bouncy Castle

License Copyright (c) 2000 - 2004 The Legion Of The Bouncy Castle (http://www.bouncycastle.org)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to
deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Castor Library

The original license is found at http://www.castor.org/license.html

The code of this project is released under a BSD-like license [license.txt]:
Copyright 1999-2004 (C) Intalio Inc., and others. All Rights Reserved.

Redistribution and use of this software and associated documentation ("Software"), with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain copyright statements and notices. Redistributions must also contain a copy of this document.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. The name "ExoLab" must not be used to endorse or promote products derived from this Software without prior written permission of Intalio Inc.
For written permission, please contact info@exolab.org.

4. Products derived from this Software may not be called "Castor" nor may "Castor" appear in their names without prior written permission of Intalio
Inc. Exolab, Castor and Intalio are trademarks of Intalio Inc.



5. Due credit should be given to the ExoLab? Project (http://www.exolab.org/).

THIS SOFTWARE IS PROVIDED BY INTALIO AND CONTRIBUTORS ""AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTALIO OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Indiana University Extreme! Lab Software License

Version 1.1.1

Copyright (c) 2002 Extreme! Lab, Indiana University. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software
developed by the Indiana University Extreme! Lab (http://www.extreme.indiana.edu/)."

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The names "Indiana University" and "Indiana University Extreme! Lab" must not be used to endorse or promote products derived from this software
without prior written permission. For written permission, please contact http://www.extreme.indiana.edu/.

5. Products derived from this software may not use "Indiana University" name nor may "Indiana University" appear in their name, without prior
written permission of the Indiana University.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHORS, COPYRIGHT HOLDERS OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

JDOML.JAR

Copyright (C) 2000-2002 Brett McLaughlin & Jason Hunter. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the disclaimer that follows these conditions in
the documentation and/or other materials provided with the distribution.

3. The name "JDOM" must not be used to endorse or promote products derived from this software without prior written permission. For written
permission, please contact license@jdom.org.

4. Products derived from this software may not be called "JDOM", nor may "JDOM" appear in their name, without prior written permission from the
JDOM Project Management (pm@jdom.org).

In addition, we request (but do not require) that you include in the end-user documentation provided with the redistribution and/or in the software itself
an acknowledgement equivalent to the following: "This product includes software developed by the JDOM Project (http://www.jdom.org/)."

Alternatively, the acknowledgment may be graphical using the logos available at http://www.jdom.org/images/logos.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE JDOM AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Phaos

This Software is derived in part from the SSLavaTM Toolkit, which is Copyright ©1996-1998 by Phaos Technology Corporation. All Rights
Reserved. Customer is prohibited from accessing the functionality of the Phaos software.

W3C

W3C® SOFTWARE NOTICE AND LICENSE

This work (and included software, documentation such as READMEs, or other related items) is being provided by the copyright holders under the
following license. By obtaining, using and/or copying this work, you (the licensee) agree that you have read, understood, and will comply with the
following terms and conditions.

Permission to copy, modify, and distribute this software and its documentation, with or without modification, for any purpose and without fee or



royalty is hereby granted, provided that you include the following on ALL copies of the software and documentation or portions thereof, including
modifications:

1. The full text of this NOTICE in a location viewable to users of the redistributed or derivative work.

2. Any pre-existing intellectual property disclaimers, notices, or terms and conditions. If none exist, the W3C Software Short Notice should be
included (hypertext is preferred, text is permitted) within the body of any redistributed or derivative code.

3. Notice of any changes or modifications to the files, including the date changes were made. (We recommend you provide URIs to the location from
which the code is derived.)

THIS SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS," AND COPYRIGHT HOLDERS MAKE NO REPRESENTATIONS OR
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF THE SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE ANY
THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.

COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF ANY USE OF THE SOFTWARE OR DOCUMENTATION.

The name and trademarks of copyright holders may NOT be used in advertising or publicity pertaining to the software without specific, written prior
permission. Title to copyright in this software and any associated documentation will at all times remain with copyright holders.
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About This Book

Purpose

This guide describes how to use the Novell exteNd ComposerTM Connect for Baan. This product has
design-time as well as runtime executables and uses J2EE Connector Architecture technology to provide
integration capability.

Audience

This book is for developers and systems integrators who are planning to use Novell exteNd Composer to
develop services and components for Baan.

Prerequisites

You should be familiar with the exteNd Composer work environment and deployment options. You also
should be familiar with Baan. Familiarity with Java Connector Architecture is helpful but not required.

Software Versions

This guide assumes that you are using Novell exteNd Composer (Enterprise or Professional) version 5.2
(or higher) and that you are deploying your applications to a Java 2 Platform, Enterprise Edition (J2EE)
Version 1.3 or equivalent application server.

The Novell exteNd Composer Connect for Baan supports Baan IVc and above.

Additional Documentation

For the complete set of Novell exteNd documentation, see the Novell Documentation Web site
(http://www.novell.com/documentation-index/index.jsp).


http://www.novell.com/documentation-index/index.jsp
http://www.novell.com/documentation-index/index.jsp
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Welcome to the Novell exteNd Composer
Connect for Baan

Welcome to the Novell exteNd Composer Connect for Baan User s Guide. This Guide is a companion to
the Novell exteNd Composer User’s Guide, which describes how to use all the features of Composer
except for the Connect Component Editors. You should be familiar with the Composer Users Guide
before using this Guide.

Novell exteNd ComposerTM provides separate Component Editors for each Connect, including the
Connect for Baan. The special features of each component editor are described in separate Guides, like
this one.

If you have been using exteNd Composer and are familiar with the core component editor (the XML Map
Component Editor), then this Guide should be enough to get you started with the Baan Component
Editor.

NOTE: To be successful with this Component Editor, you must be familiar with Baan and basic XML
integration concepts.

About Novell exteNd Composer™

Novell exteNd Composer is the XML integration-broker component of the Novell exteNd suite. It
encompasses a set of design tools for building XML integration applications and Web services, plus a
runtime engine that enables execution and administration of the services that you build. The applications
and services that you build with Composer can be deployed to any popular J2EE application server or
servlet container. Supported application servers include JBoss, IBM WebSphere and BEA WebLogic in
addition to the Novell exteNd application server. Apache Jakarta Tomcat is also supported. Check the
Novell Web site for latest platform-support information.

At the core of Composer is a robust XML transformation engine capable of performing a wide range of
data transformations, including joining of multiple documents, decomposition of documents, and
creation of entirely new documents. The underlying enabling technologies include XSLT, XPath,
ECMAScript, and Java. The Composer design environment offers a rich, intuitive graphical user
interface, making it possible for you to specify XML transformations and mappings visually, using
wizards, dialogs, and drag-and-drop gestures. You never have to write raw XSL or Java code.

Composer supports numerous kinds of data-source connectivity, through individual adapters called
Connects. Using the functionality exposed in the various Connects, you can design EAI applications and
Web services that pull data in from or push data out to different kinds of back-end systems, using a variety
of transport protocols and technologies, ranging from 3270 and 5250 terminal data streams to Telnet,
HP3000, Unisys T27 (and UTS), Tandem, and Data General, in addition to HTML screen-scraping, JMS
messaging, and CICS RPC transactions. You can also take advantage of JDBC, LDAP, and other
mechanisms to reach back-end data repositories and systems that might or might not natively understand
XML. Composer Connects allow you to connect to these systems inobtrusively, so as to marshall non-
XML data into XML form or vice versa without any need to modify host-system setups or code.

Welcome to the Novell exteNd Composer Connect for Baan 11
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Terminal Streams

In addition to legacy data-stream and protocol-specific Connects, Composer has Connects for ERP and
CRM systems, including PeopleSoft, SAP, Lawson, Oracle E-Business Suite, J.D. Edwards, and Siebel.
As with other Connect solutions, the ERP and CRM Connects are fully integrated into Composer’s
design-time environment so that you can use intuitive visual tools to create powerful custom integration
solutions, eliminating the need to write Java code or edit raw XML or schemas by hand. You can also test
the components that you build against live Baan connections, using the animation facility (step-through
debugger) of the design environment. As part of the design and debug process, your Oracle-aware
components can call other Composer Components (such as XML Map Components, JDBC Components,
etc.) and make use of any of the core actions that Composer defines (such as Map, Function, Log, and
other actions).

About the Composer Connect for Baan

The Novell exteNd Composer Connect for Baan allows you to build powerful XML-based integration

solutions and enables you to reuse your existing Baan business functions with other applications—the

key to building a successful e-business or integrated enterprise. The Composer Connect enables you to
incorporate Baan business objects and services into new application initiatives.

You do not need to manually generate or install Baan XML schemas in order to use the Composer
Connect for Baan. The Connect will generate schemas for you, as needed, automatically.

You also don’t have to take any steps to preinstall RARs (resource adapter archives, defined by the Java
Connector Architecture) on the target application server ahead of time. Composer handles RAR
deployment for you automatically when you deploy any Composer-built service that utilizes the
Composer Connect for Baan.

NOTE: Some one-time setup and configuration steps are required in order to use the Composer Connect
for Baan. These steps are described in Chapter 2, “Getting Started With the Composer Connect for Baan”.

12 Novell exteNd Composer 5.2.1 Connect for Baan User’s Guide



About J2EE Connector Architecture

The J2EE Connector Architecture (JCA) defines a standard architecture for connecting elements of the
J2EE platform to a heterogeneous Enterprise Information System (EIS). Examples of EIS components
include Enterprise Resource Planning (ERP) systems, Customer Relationship Management (CRM),
Supply Chain Management (SCM), mainframe transaction processing, database systems, and legacy
applications that are not written in the Java programming language. By defining a common set of
scalable, secure, transactional mechanisms reachable via a standard set of APIs, J2EE Connector
Architecture enables the integration of an EIS with an application server and enterprise applications.

The J2EE Connector Architecture permits an EIS vendor to provide a standard resource adapter for its
EIS. The resource adapter plugs into an application server, providing connectivity to an EIS, and
integrating it with the rest of the enterprise. If an application server vendor has extended its system to
support J2EE Connector Architecture, it is assured of seamless connectivity to multiple Enterprise
Information Systems.

Before J2EE Connector Architecture, most EIS vendors offered vendor-specific architectures to provide
connectivity between applications and their software. Each program interacting with an EIS needed to be
hand-tooled by someone with a detailed knowledge of the target EIS. Custom software to provide
connectivity across multiple systems was time consuming to develop, debug, and maintain.

By providing a standard set of APIs and contracts for managing connectivity, exposing EIS APIs, and
using application-server services (like transaction control and connection pooling), J2EE Connector
Architecture greatly reduces the need for custom programming. Developers can focus on business logic
rather than connectivity and transaction-related logic and a variety of “plumbing issues.”

How J2EE Connector Architecture Works
The “major participants” in J2EE Connector Architecture include these components:

+ Application server
+ Resource adapter (RAR)
+ Application

The application server is not strictly required. Certain services like connection pooling and transaction
control will not be available in a “server” that is just a servlet container. But J2EE Connector Architecture
resource adapters can still operate.

The RAR represents the interests of the underlying EIS.

The application interacts with the resource adapter using what J2EE Connector Architecture calls
standard contracts. Standard contracts define what interactions are to take place and how they are
exposed. The contract between the application and the resource adapter is called the Common Client
Interface (CCI). The resource adapter, in turn, interacts with the application server under the Service
Provider Interface (SPI), which defines how the management of resource adapter interactions occurs.
The aspects of this include:

+ Connectivity management

+ Transaction demarcation

+ Event listening (listeners can receive notification of significant events; for example, a connection
failure)

+ Pooling of connections and other resources

In the normal course of events, the application uses a naming service to locate the appropriate resource
adapter. The application server supplies the naming service, and so it recognizes that a request is being
made to locate a resource adapter. In such a case, the application server interposes a resource-adapter-
supplied intermediate object that interacts between the resource adapter and the application server.
Through this intermediating object, the application server manages the items within the SPI contract
below the awareness of the application.

Welcome to the Novell exteNd Composer Connect for Baan 13



For more information about J2EE Connector Architecture, visit http://java.sun.com/j2ee/connector/.

About iWay Technology

Novell exteNd Composer uses licensed J2EE Connector Architecture adapter technology from iWay
Software* (a division of Information Builders, Inc.) to mediate EIS interactions in the Composer Connect
for Baan. A leader in the J2EE Connector Architecture technology space, iWay Software provides
resource adapters and connectivity solutions across a wide array of EIS and other systems.

For more information about iWay, see http://www.iwaysoftware.com.

What Kinds of Applications Can You Build Using the Composer
Connect for Baan?

14

With Composer Connect for Baan, you can build any kind of Web service or integration application that
needs to push data into or pull data from a Baan-based data store using XML as the interchange format.
Your integration application can be deployed to a J2EE application server and run as a public web
service, or it can be used in “behind the firewall” scenarios. It can be triggered by a servlet, JSP, EJB, e-
mail, timer, file arrival, JMS message arrival, or any of the supported Composer trigger types. It can also
run standalone or as part of a workflow built using Composer Enterprise Edition’s Process Manager. (For
more information about deployment options, see “Deploying Your Project,” in the Novell exteNd
Composer User’s Guide.)

Novell exteNd Composer 5.2.1 Connect for Baan User’s Guide
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Getting Started With the Composer Connect for
Baan

This chapter describes how to set up and configure the exteNd ComposerTM Connect for Baan.

Setup and Configuration

JDBC Drivers

The following requirements must be completed before you can use the Composer Connect for Baan:

1 Determine the release number of your Baan system. The Novell exteNd Composer Connect for
Baan supports Baan I'Vc and above.

2 Locate or acquire the JDBC driver for the database used with your Baan system. See “JDBC
Drivers” on page 15.

3 Update the classpath in xconfig.xml, in both the design environment and on the server, to reflect
the addition of the JDBC driver. See “Adding the JDBC Driver to the Design-Time Environment”
on page 16 and “Adding the JDBC Driver to the Novell Application Server Environment” on
page 16.

4 Update the license for your Composer Connect for Baan installation. See “Updating the Design-
time Software License” on page 16 and “Updating the Runtime License” on page 17.

The steps necessary to accomplish these requirements are discussed in detail in the following sections.

Before attempting to use the Composer Connect for Baan (which is installed automatically as part of the
default exteNd suite installation process), you must complete the installation by obtaining and installing
the JDBC drivers for the database used with your Baan system. These files are proprietary to their
developers and are not shipped by Novell nor installed as part of the Novell exteNd Suite.

You need the following JDBC driver files, depending on the database used:

+ Oracle: ojdbc14.jar
+ Informix: ifxjdbc.jar.
+ Microsoft SQL Server: msutil.jar, msbase.jar, mssqlserver.jar

These JDBC drivers should be included in your Baan environment. If they are not, you can download the
JDBC drivers from the following Web sites:

Oracle:
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/index.html

Informix:
http://www-306.ibm.com/software/data/informix/tools/jdbc/

Microsoft SQL Server:
http://www.microsoft.com/sql/downloads/default.asp

Getting Started With the Composer Connect for Baan 15
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When you have located the JDBC driver, you must add the driver JAR files to the classpath in both your
design-time and runtime environments, as described in the following sections.

Adding the JDBC Driver to the Design-Time Environment

> To add the JDBC driver to your design-time configuration

1
2

3

If Composer is running, shut it down before proceeding.

Obtain the JDBC driver files (see “JDBC Drivers” on page 15), if they are not included in your
Baan installation.

Copy the JDBC driver files to the /Common/lib folder of the exteNd installation directory on your
design-time computer.

> To add the JDBC driver to the design-time classpath

1
2
3

4

Locate your xconfig.xml file under /Composer/Designer/bin and open the file in a text editor.

Scroll to the bottom. Within the <RUNTIME> element, you should see many <JAR> entries.

Add additional <JAR> elements that specify the path to the JDBC driver files. For example:
<JAR>..\..\..\Common\lib\ojdbcl4.jar</JAR>

The JAR entries tell the class loader where it can find the JDBC driver files.

Save and close xconfig.xml.

Adding the JDBC Driver to the Novell Application Server Environment

1
2

3

If the application server is running, shut it down before proceeding.
Obtain the JDBC driver files (see “JDBC Drivers” on page 15), if they are not included in your
Baan installation.

Copy the JDBC driver files to a suitable location on your application server. The exact location
doesn’t matter, as long as you create a classpath entry pointing to the JDBC driver file location, as
described in the following steps.

Update the application server classpath. For the Novell exteNd application server, locate the
AgJars.conf file in the AppServer/bin directory and open the file in a text editor.

Create a new entry for each JDBC driver file in the “MODULE COMMON?” section. For example:
$SS LIB ../../Common/lib/ojdbcl4.jar

This example assumes that you have placed the JDBC driver files in the application server
/Common/lib directory. Edit this path as required to reflect the actual target directory.

NOTE: For application servers other than Novell exteNd, follow the application server vendor’s
instructions for updating the classpath.

Updating the Design-time Software License

16

1

Obtain a valid license string from your Novell representative.

NOTE: You use the same license string to activate the design-time and runtime versions of
Composer Connect for Baan.

Start Composer.

Select About Composer from the Help menu. The About Extend Composer dialog box is
displayed.

Select System. The System Information dialog box is displayed.

Click on the Licenses tab, located in the upper left corner of the System Information dialog box.
The license information for your Composer installation is displayed.
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x|
Status | Licenses || Credits
Installed Component License Information
Mame License Enabled Status |
J.D. Edwards E139:52C96320050521 (] ot Loaded
J.D. Edwards Service E13852C9B320030521 (] ot Loaded
S Ect... Loaded
JMS Service | Edi... Loaled
Lawson E139:52C871 20050521 (] ot Loaded
Lawson Service E13852CE71 20050521 (] ot Loaded
Frocess Edi... Loaded
PeopleSoft E139:52C7D020050521 (] ot Loaded
PeopleSoft Service E13952C70020050521 (] Mot Loaded
Siebel E139:52C91 220050521 (] ot Loaded
Siebel Service E139:52C91 220050521 (] ot Loaded
Service Provider Edi... Loaded
Service Provider Type [ Eclit... Loaded
Terminal StyleSheet [ Edlit... Loaded
T27 Terminal | Edi... Loaled
T27 Logon | Edit... Loace
Tandem Terminal [ Edlit... Loaded
Tancem Logon | Eclit... Loaded

Scroll down until you see the row for Baan.
NOTE: The Connect ships with an Evaluation license string which may be used for 90 days.

To use the evaluation license string, select the check box in the Enabled column and skip to Step
10. To enter a different license string, select the check box in the Enabled column. The Edit button
in the Siebel row is enabled.

Select Edit in the Baan row. The Edit License dialog box is displayed.

Edit License x|
Product Mame baan
New License |

I ............ 5 K” Cancel ]

Type the license string for the Composer Connect for Baan in the New License field.

Scroll down until you see the row for Baan Service.
Repeat Step 7 through Step 9 for the Baan Service row.
Exit out of all dialogs by selecting OK.

Updating the Runtime License

1
2

Make sure that the Novell exteNd Composer Enterprise Server is installed.
Start the application server. The Novell exteNd Composer Enterprise Server starts automatically
when you start the application server.

Open a browser window and navigate to the Novell exteNd Composer main administrative console.
Typically, this is at:
http://localhost/exteNdComposer

In the upper left corner of the console window, click the exteNd Composer logo immediately
above the words “Server Console,” as shown in the following illustration.
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exteNd Compo%?r YersionLicenze Manager
(=Y B E S

General Properties = Nove“@exteNdm Composer

|Versi|:|n ]

About Products:

5 In the content area of the main frame, near the bottom, click Licenses. The Manage Licenses
window is displayed. This window shows the license status of every Composer Connect. See the
following illustration.

—ialx]
exteNd Composer
B Novell.
b E13352CARAZI0E0E21 | Net Loaded © Ensblod g =l
aan ot Loade
@ Disabled
3 " Enabled
baanservice E13352CA5420050521 Mot Loaded Update
@ Disablzd
& Enabled
CICSRPC Loaded Update
" Disabled —I
& Enabled
DG Loaded Update
" Disabled —I
& Enabled
Dslozon Loaded Update
" Disabled —I
& Enabled
EDI Loaded Update
' Disabled —I
& Enabled
EDIDocumentResource Loaded Update
' Disabled =
[l | B
[&] Done [ B ocalintranet 4

6 Scroll down to the entry labeled “baan”.
NOTE: The Connect ships with Evaluation license strings which may be used for 90 days.

7 Type a license string in the text field in the “baan” row; then select Enabled in the “baan” row. To
use the evaluation license string, just select Enabled.

8 Sclect Update in the “baan” row.
Scroll down to the entry labeled “baanservice”.

10 Type a license string in the text field in the “baanservice” row; then select Enabled in the
“baanservice” row. To use the evaluation license string, just select Enabled.

11 Select Update in the “baanservice” row.
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Creating a Baan Component

To create a Component that utilizes the exteNd ComposerTM Connect for Baan, you need to do three
things:

+ Create a Connection Resource (to allow your component to connect to a Baan system)
+ Create any necessary XML Templates
o Create the Component itself (containing your business logic)

Each of these processes is discussed in detail in this chapter.

Creating a Connection Resource

Before creating a component that interacts with a Baan system, you need to create a Connection
Resource, which is a lightweight Composer object (xObject) that encapsulates basic connection
information (parameter values) associated with a connection to a back-end system.

In addition to a connection resource, a Baan Component requires that you have already created XML
templates so that you have sample input and output documents for use in designing your component. For
more information, see “Creating an XML Template” in the Novell exteNd Composer User s Guide.

If your component design calls for any other resources, such as custom scripts, XSL, XSD, etc., you
should create these before creating the Baan Component. For more information, see “Creating Custom
Scripts” in the Novell exteNd Composer User s Guide.

Types of Connection Resources

You create different types of connection resource depending on the type of interaction with the Baan
system that is desired. If your application needs to initiate Baan business events, you need to create a
Baan Connection resource. If your application needs to process data when a business event occurs within
the Baan system, you need to create a Baan Service connection. Baan Service connections include the
Baan Service EDA Connection, Baan Service JDBC-ODBC connection, Baan Service Oracle
Connection, and Baan Service SQL Server Connection.

About Constant-Driven and Expression-Driven Connection Parameters

You can specify Connection parameter values in one of two ways: as Constants or as Expressions. A
constant-driven parameter uses the value you type in the Connection dialog every time the Connection is
used. An expression-driven parameter allows you to set the value using a programmatic expression,
which can result in a different value each time the connection is used at runtime. This allows the
Connection’s behavior to be flexible and vary based on runtime conditions each time it is used.
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For instance, one very simple use of an expression-driven parameter in a Connection would be to define
the User ID and Password as PROJECT Variables (e.g.
PROJECT.XPATH(“USERCONFIG/MyDeployUser”). This way when you deploy the project, you can
update the PROJECT Variables in the Deployment Wizard to values appropriate for the final deployment
environment. At the other extreme, you could have a custom script that queries a Java business object in
the Application Server to determine what User ID and Password to use.

> To switch a parameter from Constant-driven to Expression driven:
1  Click the right mouse button in the parameter field you are interested in changing.

2 Sclect Expression from the context menu and the editor button will appear or become enabled.

B[
@ ECMA Expression
vse.. | 3 LDAP Expression

3 Click on the button and then create an expression that evaluates to a valid parameter value at
runtime. (Strings should be wrapped in double-quotes.)

Creating a Baan Connection Resource

> To Create a Baan Connection Resource:
1 Select File > New > xObject. The New xObject dialog box is displayed.
2 Select the Resource tab.

3 Double-click on Connection. The “Create a New Connection Resource” wizard is displayed.

Create a New Connection Resource x|

A Connection resoumce is used to establish communications with an Connector data source or with a senver
using HTTP authentication. You need to create connections for each type of data source or each HTTP server
you wish o communicate with. Enter a name and, optionally, & description for this Connection. The name will
appear in the Com poser Detail Pane and in choice lists when you are prom pled for objects in Com poser. The
name may notcontain the characters: 1?7 " <> | Names ae case insensitive.

Mame:

FaanCDnnectiDn

Description:

urpose:

Input:
utput:
emarks:

|[ Next > ][ Cancel

4 Type a Name for the connection object.

a

Optionally, type Description text.
6 Sclect Next. A connection parameters panel is displayed.
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14

Create a New Connection Resource 1[

Specify Baan specific paramelers here to make connection io Baan EIS.

Connection Type IEaan Connhection Test

Database Driver I D Defautt

Database URL |

user |

Password I

Maximum Pool Size |1D

[ < Back ][ Finish H Cancel

Select Baan Connection from the Connection Type list.

In the Database Driver field, type the fully-qualified name of the JDBC driver used to access the
Baan database. For example, the following paragraphs show the fully-qualified names of the JDBC
drivers for databases frequently used with Baan:

+ Oracle: oracle.jdbc.driver.OracleDriver
+ Informix: com.informix.jdbc.IfxDriver
+  Microsoft SQL Server: com.microsoft.jdbe.sqlserver.SQLServerDriver

In the Database URL field, type the URL of the JDBC driver that is used to communicate to the
database. The following table provides examples for databases frequently used with Baan.

Database  Format Example

Oracle jdbc:oracle:thin:Q@host: jdbc:oracle:thin:
port:servicename @oraclellx:1523:VIS

Informix jdbc:informix— jdbc:informix—
sqli://[hostname]: [port/ sgli://unxso0l26:5053/
database] :informixserver=[your- jade:informixserver=online
sever-name] 920

Microsoft jdbc:microsoft:sglserver://hostname: jdbc:microsoft:sglserver:

SQL port[;property=value...] //serverl:1433;user=

Server test;password=secret

In the User ID field, type a Baan user ID.
In the Password field, type the password for the user specified in the User ID field.

In the Maximum Pool Size field, type the desired maximum pool size. This is a JCA setting that
specifies the maximum number of connections to be allowed in the connection pool (not applicable
for non-managed environments).

If desired, select Test to see if your connection parameters and network environment allow you to
create a live connection. Composer displays a message indicating the success or failure of the test.
The test connection is discarded immediately after the test. You can continue working with the
connection resource, even if the connection fails.

NOTE: This test does not test the connection pool.

Select OK. The newly-created connection resource appears in the Composer Connection Resource
detail pane.
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Ready

Creating a Baan Service EDA Server Connection Resource

Use this connection type if you need to listen for events on a non-relational database system.

> To Create a Baan Service EDA Server Connection Resource:
1 Select File > New > xObject. The New xObject dialog box is displayed.
Select the Resource tab.
Double-click on Connection. The “Create a New Connection Resource” wizard is displayed.
Type a Name for the connection object.
Optionally, type Description text.

O a b WON

Select Next. A connection parameters panel is displayed.

Create a New Connection Resource x|

This panel is used to specify connection information. The Connection Type drop down is used o select the
type of connection you wish 1o create. For the 3270 type connections, including EF, the CICS region and
address are required. For JOBC type connneclions, one must specify the JDBEC driver, the server addness,
anda userlD and Password, if regquired.

Connection Type IBaan Service EDS Server Connection Test

Host or IP Address I [ Defautt

EDA Server Port I

Database Name I

User ID I

Password I

Polling Interval I

S0L Query I

Post Query I

[ < Back “ Finish “ Cancel ]

7 Select Baan Service EDA Server Connection from the Connection Type list.

8 In the Host or IP Address field, type the name of the server on which the Baan database instance
resides.

9 Inthe EDA Server Host Port ficld, type the port number on which the database is listening.
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In the Database Name ficld, type the name of the database.

In the User ID field, type a database user ID. The user ID must have database access to the
interface tables.

In the Password field, type the password for the user specified in the User ID field.

In the Polling Interval field, type the interval (in milliseconds) in which the host is checked for
input. The default is 3000 (3 seconds).

Leave the SQL Query field blank. Entering a value may corrupt data.
Leave the Post Query field blank. Entering a value may corrupt data.
Leave the Delete Keys field blank. Entering a value may corrupt data.

From the Metadata Connection list, select a Baan Connection resource from the list of defined
Baan Connection resources. This connection is used for acquiring metadata from the Baan system.

Type the desired maximum pool size in the Maximum Pool Size field. This is a JCA setting that
specifies the maximum number of connections to be allowed in the connection pool (not applicable
for non-managed environments).

If desired, select Test to see if your connection parameters and network environment allow you to
create a live connection. Composer displays a message indicating the success or failure of the test.
The test connection is discarded immediately after the test. You can continue working with the
connection resource, even if the connection fails.

NOTE: This test does not test the connection pool.

Select OK. The newly-created connection resource appears in the Composer Connection Resource
detail pane.

Creating a Baan Service JDBC-ODBC Connection Resource

> To Create a Baan Service JDBC-ODBC Connection Resource:

1

o a b~ WON

7
8

Select File > New > xObject. The New xObject dialog box is displayed.

Select the Resource tab.

Double-click on Connection. The “Create a New Connection Resource” wizard is displayed.
Type a Name for the connection object.

Optionally, type Description text.

Select Next. A connection parameters panel is displayed.

Create a New Connection Resource x|

Specify Baan Senvice JOBC-ODEC specific parametars here th make connection t Baan EIS

Connection Type IBaan Service JDEC-CDBEC Connection Test

User ID I [ Defautt

Password I

Polling Interval I

SGL Query I

Post Query I

Delete Keys I

hetadata Connection I

Maximum Pool Size |1 1]

[ < Back “ Finish H Cancel ]

Select Baan Service JDBC-ODBC Connection from the Connection Type list.

In the Data Source field, type the name of the database to which you are connecting.
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In the User ID field, type a database user ID. The user ID must have database access to the
interface tables.

In the Password field, type the password for the user specified in the User ID field.

In the Polling Interval ficld, type the interval (in milliseconds) in which the host is checked for
input. The default is 3000 (3 seconds).

Leave the SQL Query field blank. Entering a value may corrupt data.
Leave the Post Query field blank. Entering a value may corrupt data.
Leave the Delete Keys field blank. Entering a value may corrupt data.

From the Metadata Connection list, select a Baan Connection resource from the list of defined
Baan Connection resources. This connection is used for acquiring metadata from the Baan system.

Type the desired maximum pool size in the Maximum Pool Size field. This is a JCA setting that
specifies the maximum number of connections to be allowed in the connection pool (not applicable
for non-managed environments).

If desired, select Test to see if your connection parameters and network environment allow you to
create a live connection. Composer displays a message indicating the success or failure of the test.
The test connection is discarded immediately after the test. You can continue working with the
connection resource, even if the connection fails.

NOTE: This test does not test the connection pool.

Select OK. The newly-created connection resource appears in the Composer Connection Resource
detail pane.

Creating a Baan Service Oracle Connection Resource

24

> To Create a Baan Service Oracle Connection Resource:

1

O a h WON

7
8

Select File > New > xObject. The New xObject dialog box is displayed.

Select the Resource tab.

Double-click on Connection. The “Create a New Connection Resource” wizard is displayed.
Type a Name for the connection object.

Optionally, type Description text.

Select Next. A connection parameters panel is displayed.

Create a New Connection Resource ll

Specify Baan Service Oracle specific parameters here 1o make connection fo Baan EIS.

Connection Type IEiaan Service Oracle Connection Test
Host or IP Address | O Defaut
Oracle Host Part |
so |
user D |
Password I
Poling Interval |
SGL Query |
Post Query |

[ < Back ][ Finish ][ Cancel ]

Select Baan Service Oracle Connection from the Connection Type list.

In the Host or TP Address ficld, type the name of the server on which the Baan database instance
resides.
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In the Oracle Host Port field, type the port number on which the database is listening.

In the SID field, type the name of the database service. The SID is a unique name that is specified
by the database administrator or the person who installed the Baan system.

In the User ID field, type a database user ID. The user ID must have database access to the
interface tables.

In the Password field, type the password for the user specified in the User ID field.

In the Polling Interval ficld, type the interval (in milliseconds) in which the host is checked for
input. The default is 3000 (3 seconds).

Leave the SQL Query field blank. Entering a value may corrupt data.
Leave the Post Query field blank. Entering a value may corrupt data.
Leave the Delete Keys field blank. Entering a value may corrupt data.

From the Metadata Connection list, select a Baan Connection resource from the list of defined
Baan Connection resources. This connection is used for acquiring metadata from the Baan system.

Type the desired maximum pool size in the Maximum Pool Size field. This is a JCA setting that
specifies the maximum number of connections to be allowed in the connection pool (not applicable
for non-managed environments).

If desired, select Test to see if your connection parameters and network environment allow you to
create a live connection. Composer displays a message indicating the success or failure of the test.
The test connection is discarded immediately after the test. You can continue working with the
connection resource, even if the connection fails.

NOTE: This test does not test the connection pool.

Select OK. The newly-created connection resource appears in the Composer Connection Resource
detail pane.

Creating a Baan Service SQL Server Connection Resource

> To Create a Baan Service SQL Server Connection Resource:

1

O a h WON

Select File > New > xObject. The New xObject dialog box is displayed.

Select the Resource tab.

Double-click on Connection. The “Create a New Connection Resource” wizard is displayed.
Type a Name for the connection object.

Optionally, type Description text.

Select Next. A connection parameters panel is displayed.

Create a New Connection Resource ll

Specify Baan Service Oracle specific parameters here 1o make connection fo Baan EIS.

Connection Type IEiaan Service Oracle Connection Test
Host or IP Address | O Defaut
Oracle Host Part |
so |
user D |
Password I
Poling Interval |
SGL Query |
Post Query |

[ < Back ][ Finish ][ Cancel
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7 Sclect Baan Service SQL Server Connection from the Connection Type list.

8 In the Host or IP Address field, type the name of the server on which the Baan database instance
resides.

9 Inthe SQL Server Port field, type the port number on which the database is listening.
10 In the Database Name ficld, type the name of the database.

11 In the User ID field, type a database user ID. The user ID must have database access to the
interface tables.

12 In the Password field, type the password for the user specified in the User ID field.

13 In the Polling Interval field, type the interval (in milliseconds) in which the host is checked for
input. The default is 3000 (3 seconds).

14 Lecave the SQL Query field blank. Entering a value may corrupt data.
15 Lecave the Post Query field blank. Entering a value may corrupt data.
16 Lcave the Delete Keys field blank. Entering a value may corrupt data.

17 From the Metadata Connection list, select a Baan Connection resource from the list of defined
Baan Connection resources. This connection is used for acquiring metadata from the Baan system.

18 Type the desired maximum pool size in the Maximum Pool Size field. This is a JCA setting that
specifies the maximum number of connections to be allowed in the connection pool (not applicable
for non-managed environments).

19 If desired, select Test to see if your connection parameters and network environment allow you to
create a live connection. Composer displays a message indicating the success or failure of the test.
The test connection is discarded immediately after the test. You can continue working with the
connection resource, even if the connection fails.

NOTE: This test does not test the connection pool.

20 Sclect OK. The newly-created connection resource appears in the Composer Connection Resource
detail pane.

XML Templates for Baan Components

Before creating a Baan Component, you should create any XML templates that might be needed. XML
templates are used to tell Composer which XML sample documents (e.g., input, output, scratch pad,
fault, XSD, or DTD) to use. Once you’ve specified the XML templates, you can create a component that
uses the sample documents to represent the inputs and outputs processed by your component. For more
information about XML templates, see “Creating a New XML Template” in the Novell exteNd Composer
User s Guide.

Creating Baan Components

26

As part of the process of creating a Baan Component, you can select an existing Baan connection

resource, or you can create a new one. If you create the connection beforehand, it is available for use by
any Baan Components in the current project. If you have not already created at least one Baan connection
resource in the current project, you will be prompted to do so when you try to create a Baan Component.

NOTE: You can still create a Component without first creating a Connection Resource, but you won’t be
able to use any debug features that depend on a live connection.
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> To Create a New Baan Component:

1

a

Select File>New>xObject. The New xObject dialog box is displayed.

NOTE: Alternatively, under Component in the Composer Navigator pane (Explorer view), you can
highlight Baan, click the right mouse button, then select New.

Select the Component tab.

Double-click on “Baan.”

If you have not previously defined a connection resource, you are prompted to do so now (see

“Creating a Connection Resource” on page 19).

If you have already defined a connection resource, the “Create a New Baan Component” Wizard is

displayed.

Create a New Baan Component x|

A Baan Component connects 10 an application, processes the data using elements from aDOM, and maps
the results to an outputDOM . Use this wizard io create a Baan Component. Entera name and description for
the component. The name will appear in the Designer Detail Pane and in choice lists when you are prom pted
for objects in Designer. The name may not contain the characters: /2 ? " <= | Names are case insensitive

({i.e. MyDbject is the same as myobject)

Mame:

F}aanCom ponent

Description:

urpose:
Input:

utput:

emarks

|[ Next > ][ Cancel

Type a Name for the new Baan Component.

Optionally, type Description text.

Select Next. The XML Input/Output Message Property Info panel of the New Baan Component

Wizard is displayed.

Create a New Baan Componenkt x|

Specify one or mone XML Tem plates 1o help oesign Input i3 this Com ponent or Wieb Senice and only one 1o
design Output. The sample XML Documents ineach Template ane design time aids to help you build Action
Models for the component. The samples are not actually used at runtime after deployment 1o your application
server. The ldentifier is fixed and represents the name usedto refer fo the *ML Document during component
execution. Selecting System [AN Y} allows you fo use an empty template {i.e. acceptany document as Inpuf).

nput Message

Part ‘ Template Category Template Mame
Input |{Sys‘tem} {ANY}
utput Message
Part ‘ Template Category Template MName
Output | isystem) AR
Help @) [ < Back “ Next > H Cancel ]

7 Specify the Input and Output templates as follows:

+ Type a name for the template under Part if you wish the name to appear in the DOM as

something other than “Input”

+ Select a Template Category if it is different than the default category.

+ Select a Template Name from the list of XML templates in the selected Template Category.

Creating a Baan Component
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10

11

12
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+ To add additional input XML templates, click Add, then choose a Template Category and
Template Name for each.

+ Toremove an input XML template, select an entry and click Delete.

Select an XML template for use as an Output DOM using the procedure described in the previous
step.

NOTE: You can specify an input or output XML template that contains no structure by selecting
{System}{ANY} as the Input or Output template. For more information, see “Creating an Output
Document without Using a Template” in the Novell exteNd Composer User’s Guide.

Select Next. The Temp and Fault XML Template panel is displayed.
X

Specify one or more Temp and Fault ML Tem plates to help design tem porary pars and fault handling for this
Componentor Web Senvice. Use Temp documents for creating intermediate results ar holding values for
reference. Specify XML Tem plates 1o serve as Fault documents o be passed back to clients undzrerror
conditions.

Temp Message

Part Template Category Template MName

Add

Delete

Fault Message

Part | Template Category Template MName
systenFaut [isystemy [ || Fauts [~]

cld

Delete

[ < Back ][ Next > ][ Cancel ]

If desired, specify a template to be used as a scratch pad under the “Temp Message” pane of the
dialog box. This can be useful if you need a place to hold values that will be used temporarily
during the execution of your component. Select a Template Category if it is different than the
default category. Then select a Template Name from the list of XML templates in the selected
Template Category.

Under the “Fault Message” pane, select an XML template to be used to pass back to clients when
an error condition occurs.

To add additional input XML templates, click Add and choose a Template Category and
Template Name for each. Repeat as many times as desired. To remove an input XML template,
select an entry and click Delete.

Select Next. The Connection Info panel of the Create a New Baan Component wizard is displayed.

Create a New Baan Component 5'

Specity which Connection you wish to use for this Component or Service. To change any connection
parameters, you must change them in the Connection Resource object or create & new Connection Resource
of the same type with different parameters.

Connection IBaanConnection Test

Database Driver |

Database URL |

User D |

ﬁﬁﬁﬁﬁ

Password r

Maximum Pool Size I

< Back ][ Finish ][ Cancel
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14 Select a Baan connection from the Connection list. The Connection list displays the names of the
Baan connection resources that have been defined in this project.

15 Select Finish. The component is created and the Baan Component Editor is displayed.

About the Baan Component Editor Window

The Baan Component Editor includes all of the functionality of the XML Map Component Editor. It
contains mapping panes for Input and Output XML documents, as well as an Action Model.

The Baan Component Editor also includes a Native Environment pane, which appears as a grey pane
until you create a Baan Request action, at which time it will show a tabs for Request and Response panes
with corresponding XML trees.

=il
File Edit View Componert Action Animste Tools Window Help HO -& x
QORGSR X |5 4 S Novell
|‘ % BaanComponert w
3 Input bata O x

Input Native Environment

mapping pane pane
= Output bata Ox & 5= Eﬁ | Q il

Qutput .

. Action Model pane

mapping pane P

Feadv

The Native Environment pane shown in the illustration is blank, because no Baan Request action has
been created.

Creating Actions in the Component Editor

You can create all the normal Composer actions in the Action Model of your Baan component (e.g., XML
Map, Function, Log, Send Mail). In addition, you can create a Baan Request action.

The Baan Request action communicates requests (XML request documents) to your Baan system and
fetches responses back from the same system.

The Composer GUI for creating a Baan Request action allows you to

+ Specify the type of Baan business function that you want to invoke

+ Automatically generate XML schemas (request and response) for the particular business function
that you want to use

+ Use the generated schemas to fine-tune the structure of the actual request document that you want
to use (a request document that conforms to the schema but reflects your own “setup” choices and
initialization parameters, etc.)

+ Automatically generate XML request and response documents that conform to the schemas and
choices that you’ve made

You will see how this works in the following procedure.
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> To Create a Baan Request Action

1

Right-click in the Action Model at the location in which you want the new action to appear, then
select New Action > Request.

Mew Action k Request, .
Edlit Action... Advances N
Dizable Action Data Exchange Y
Toggle Breakpoirt Process 4
Clear all Ereakpoints Repest 3
Cut Comment... Ctri+E
Copy Componert...  Ctrl+T
Decision... Ctri+D
Delete... Declare Alias...
Find... Function... Ctri+L
Finel Mext Log... Ctri+L
Replace. .. Map... Ctrl+i
Senc Mail...
Switch...
Todo...

The Function pane of the Request dialog box is displayed. You use this pane to browse the
available Baan functions.

Click on the plus (+) sign to the left of a node in the tree view to expand the tree view for that node.

NOTE: If no nodes are displayed on the Function page, there may be an incorrect parameter in
your connection resource. Check the parameters needed for connecting to your Baan server, then
update your connection resource if necessary (see “Creating a Connection Resource” on page 19).

Position the mouse pointer over a node in the tree view to get ToolTip information about the node.
ToolTips display the following information, depending on the node type:

+ Folder: “type - Folder”

+ Searchable Folder nodes: “type - Service”

+ Function nodes: “type - Operation”

Click on the plus sign to the left of a node to see the contents of the node.

Right-click on the desired operation, then select Get Schemas from the context menu. After a few
seconds, the Request and Response tabs of the Request dialog box are enabled.

Select the Request tab. The Request pane is displayed.

Type a name for the request message in the Request Message field, or accept the default name, as
shown in the preceding illustration.

Expand the nodes of the Request Tree by clicking on the plus signs to the left of the nodes.

Select the elements that you want to include in the Request document by selecting or deselecting
the check boxes in the node tree. Some nodes are greyed out (disabled). This is because the
document schema determines the nodes that you can edit.

Composer strictly enforces schema rules. In other words, Composer will not let you specify an
invalid request document. Items that you should not edit are disabled, and items that you can edit
have context-menus that non-customizable nodes do not have. For example:

e Mandatory elements and attributes are marked selected and disabled.
o All child nodes are left unselected and disabled if the parent node is not selected.

+ A parent element, once selected, will autoselect mandatory elements and attributes of its
children.
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+  When a parent node is selected, you will need to select optional elements manually.

ToolTips are an important aid in using the Request and Response panes, because they display
document-structure rules from the request and response document schema. Familiarize yourself
with the ToolTip feature by letting the mouse hover over various nodes, as shown in the following
illustration.

NOTE: The ToolTips that appear in this tree are also available in the Native Environment pane.

If a node has a Maximum Occurrence property of greater than one, a command called “Create
new...” is available by right-clicking on the node. Selecting that command brings up the following
dialog box:

x

Enter number of new nodes

—

[ Help @ [ 0K " Cancel l

Enter the number of additional instances of this node-type that you want to insert in the document,
then click OK. New nodes are added to the document structure.

CAUTION: There is no Undo for this operation.

If an enumeration button ([)) is displayed to the right of a given node, you can click the button to
choose from the list of appropriate (schema-allowed) values for that enumeration.

You can customize the operation of the selected method by selecting a parameter from an
enumeration, as shown in the following illustration.

Visit all of the nodes in the request tree that are of interest to you, and use the Composer user
interface features described in the preceding steps to customize the request document structure.

Click the Response tab at the top of the dialog box to bring the Response document pane forward.
This pane shows a tree view of the Response document, similar to the one shown for the Request
document. The same user interface features that applied to the Request document pane apply to the
Response document pane.

Type a name for the response message in the Response Message field, or accept the default
response message name.

Select or deselect Filter Response, as desired. Filter Response is selected by default. If
deselected, the tree will be disabled and greyed (no longer editable), indicating that a default
schema configuration will be used. If selected, you can customize the structure of the request
document by selecting the nodes to be included in the response document.

Visit all of the nodes in the Response document tree and customize the settings as desired.

Select OK. The dialog closes and a new action appears in the Action Model of your component.
The Native Environment Pane changes to show the Request and Response tabs along with tree
views of the request and response documents.

To map a node of the Input document to a node in the Request document, drag a node from the
Input pane and drop it on a node in the Request tab of the Native Environment pane. This
automatically creates a new XML Map Action in the Action Model.

To map a node of the Response document to a node in the Output document, drag a node from the
Response tab of the Native Environment pane and drop it on a node in the Output pane. This
automatically creates a new XML Map Action in the Action Model. You can cut, copy, or delete the
actions once they appear in the Action Model pane.

Add or remove actions from the Action Model to create the desired business logic.
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Returning to Schema-Edit Mode

Once you have created a Request Action in your Action Model (see “Creating Actions in the Component
Editor” on page 29), you can go back and edit the Request and Response schema trees by double-clicking
the Request Action in the Action Model. Double-clicking causes the Request dialog box to be displayed.
You can use the Request and Response tabs to navigate the request and response document schemas and
change your customizations as desired. When you exit from of the dialog box, changes are shown in the
Native Environment Pane.

NOTE: [f you manually edit the Request or Response documents in the Native Environment Pane (see
“Manually Editing the Request and Response Documents” on page 32), you will not be able to reopen the
Request Action dialog box. Avoid manually editing request/response documents. Instead, make
modifications through careful use of the XML Map Action or by using Request.createXPath( ) and DOM
methods in a Function Action.

Request and Response Documents

After you have created a Request Action (see “Creating Actions in the Component Editor” on page 29),
the Native Environment Pane portion of the Composer editor view displays Request and Response
documents in tree-view form, as shown in the following illustration.

You can drag and drop data from the Input document to the Request document to create XML Map
actions. You also can use drag-and-drop mapping to map from Response to Output. In the preceding
illustration, a node is displayed in red. The red color indicates that data has been mapped to the node.

Manually Editing the Request and Response Documents

32

If you right-click anywhere inside the Request or Response tree views in the Native Environment Pane,
a menu is displayed.

The Edit Document command in this menu opens the document in a text-editor, as shown in the
following illustration. In this window, you can manually edit the Request or Response document.

CAUTION: /f you manually edit the document, it may no longer conform to the original schema. As a
result, you will no longer be able to open the document in the Request Action dialog box.

If you have manually edited a Request or Response document, double-clicking on the corresponding
Request Action in the Action Model will cause the following message to be displayed:

zl

This Action can no longer be edited because the Request mapping message has been manually modified.

If this message appears, and you want to work with the document using the Request Action dialog box,
you must recreate the action in order to see the original Request or Response document. Manual edits will
be lost.

To prevent this situation from occurring, avoid making manual edits to Request or Response documents.
Instead use XML Map Actions and Function actions to modify documents or node contents. Be aware
that doing so may violate schema constraints. This will not necessarily cause runtime problems for your
component when executing in the Composer Enterprise Server environment, because Composer does not
validate the request document against the schema at runtime. However, your Baan system may validate
incoming requests, in which case a manually-edited Request document can cause errors that are difficult
to troubleshoot.
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“Before Execute” and “After Execute” Actions

Whenever a Baan Request action is created in the Action Model, Composer adds two additional lines to
the action list: Before Execute Actions and After Execute Actions. These are header labels (grouping
labels) for blocks of actions that occur before the request is sent to the Baan system, or affer a response
document has come back, respectively. Typically you will want to map data fields from Input to Request
and have those actions be grouped under the “Before Execute Actions” header. Likewise, any map
actions or other action logic that you need to perform on the Response document after the Baan system
executes your request should be grouped under the “After Execute Actions” heading.

Creating Baan Services

This section describes how to use the exteNd ComposerTM Connect for Baan to create a Baan Service
component to connect to Baan and listen for events. As part of the process of creating a Baan Service, you
can select an existing Baan Service connection resource, or you can create a new one. If you create the
connection beforehand, it is available for use by any Baan Services in the current project. If you have not
already created at least one Baan connection resource in the current project, you will be prompted to do
so when you try to create a Baan Service.

NOTE: You can still create a Baan Service without first creating a connection resource, but you won’t be
able to use any debug features that depend on a live connection.

> To Create a New Baan Service:
1 Select File > New > xObject. The New xObject dialog box is displayed.

NOTE: Alternatively, under Service in the Composer Navigator pane (Explorer view), you can
highlight Baan Service, click the right mouse button, then select New.

2 Select the Process/Service tab.
3 Double-click on “Baan Service.”

If you have not previously defined a connection resource, you are prompted to do so now (see
“Creating a Connection Resource” on page 19).

If you have already defined a connection resource, the “Create a New Baan Service” Wizard is
displayed.
4 Type a Name for the new Baan Service.

3]

Optionally, type Description text.

6 Seclect Next. The XML Input/Output Message Property Info panel of the New Baan Service Wizard
is displayed.

7  Specify the Input and Output templates as follows:

+ Type a name for the template under Part if you wish the name to appear in the DOM as
something other than “Input”

+ Select a Template Category if it is different than the default category.
+ Select a Template Name from the list of XML templates in the selected Template Category.

+ To add additional input XML templates, click Add, then choose a Template Category and
Template Name for each.

+ Toremove an input XML template, select an entry and click Delete.

8 Sclect an XML template for use as an Output DOM using the procedure described in the previous
step.

NOTE: You can specify an input or output XML template that contains no structure by selecting
{System}{ANY?} as the Input or Output template. For more information, see “Creating an Output
Document without Using a Template” in the Novell exteNd Composer User’s Guide.
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Select Next. The Temp and Fault XML Template panel is displayed.

If desired, specify a template to be used as a scratch pad under the “Temp Message” pane of the
dialog box. This can be useful if you need a place to hold values that will be used temporarily
during the execution of your component. Select a Template Category if it is different than the
default category. Then select a Template Name from the list of XML templates in the selected
Template Category.

Under the “Fault Message” pane, select an XML template to be used to pass back to clients when
an error condition occurs.

To add additional input XML templates, click Add and choose a Template Category and
Template Name for each. Repeat as many times as desired. To remove an input XML template,
select an entry and click Delete.

Select Next. The Connection Info panel of the Create a New Baan Service wizard is displayed.

Select a Baan Service connection from the Connection list. The Connection list displays the names
of the Baan connection resources that have been defined in this project.

Select Finish. The component is created and the Baan Service Editor is displayed. The features of
this window are identical to the features described in “About the Baan Component Editor Window”
on page 29. The following sections describe the steps required to create a Baan Service Action.

Creating Baan Service Actions

34

You can create all the normal Composer actions in the Action Model of your Baan Service (e.g., XML
Map, Function, Log, Send Mail). In addition, you can create a Baan Service Request action.

The Baan Service Request action is similar to a Switch action (see “The Switch Action” in the in the
Novell exteNd Composer User s Guide). A Switch action allows program control to branch to a block of
actions based on a match between an input value and a Case value. In a Baan Service Request, Composer
receives a DOM, and compares a series of cases against the DOM. If an exact match occurs between the
DOM and a case, execution branches to the actions listed underneath the case in the Action model. Cases
are tested in the order listed; and once a match is found, execution of the match logic precludes execution
of any other logic in the Baan Service Request.

> To Create a Baan Service Request Action

1
2
3

In the Action Model, right-click on Baan Service Request.
Select Edit Action. The Service Request dialog box is displayed.

In the Function tree, click on the plus (+) sign to the left of the Messages node to expand the tree
view for that node.

Right-click on the message name that you want to use for input and select Add Case, or double-
click on the message name. The Adapter Service Request dialog box is displayed. This dialog box
is similar to the Request dialog box (see “Creating Actions in the Component Editor” on page 29).

Select or deselect Filter Request, as desired. Filter Request is selected by default. If deselected, the
tree will be disabled and greyed (no longer editable), indicating that a default schema configuration
will be used. If selected, you can customize the structure of the request document by selecting the
nodes to be included in the request document.

Expand the nodes of the Service Request Tree by clicking on the plus signs to the left of the nodes.

Select the elements that you want to include in the Service Request document by selecting or
deselecting the check boxes in the node tree. Some nodes are greyed out (disabled). This is because
the document schema determines the nodes that you can edit.

If the Service Response tab is enabled, click the Service Response tab at the top of the dialog box
to bring the Service Response document pane forward. This pane shows a tree view of the
Response document, similar to the one shown for the Request document. The same user interface
features that applied to the Request document pane apply to the Response document pane.
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Visit all of the nodes in the Response document tree and customize the settings as desired.

Click the Case Expression tab at the top of the dialog box to bring the Case Expression pane
forward. This pane provides an Expression Builder that you use to build a case expression.

Type the static string values or the ECMAScript expressions that will be checked against the input
DOM.

Select the OK button. The Service Request dialog box is displayed.

Mapping

REQUISITIONS_INTERFACE B -

<

P

To add another case, repeat Step 3 through Step 12. The cases are listed from top to bottom in the
order in which they are evaluated. Each Case value will be checked in turn, in the order you list
them.

+ For optimal performance, list the most likely matches first.

+ You can change the order in which the cases are listed by clicking on the name of a case, then
clicking the up or down triangle icons.

+ To edit a case, select the name of the case, then press the Mapping button. You can also select
the name of the case, then select the Expression Builder button.

When you have finished adding cases, select OK. The Service Request dialog box closes and a new
action appears in the Action Model of your component. The Native Environment Pane changes to
show the Request and Response tabs along with tree views of the request and response documents.

In the Action Model, add actions to be performed to each case to create the desired business logic.

+ To map a node of the Input document to a node in the Request document, drag a node from the
Input pane and drop it on a node in the Request tab of the Native Environment pane. This
automatically creates a new XML Map Action in the Action Model.

+ To map a node of the Response document to a node in the Output document, drag a node from
the Response tab of the Native Environment pane and drop it on a node in the Output pane. This
automatically creates a new XML Map Action in the Action Model. You can cut, copy, or delete
the actions once they appear in the Action Model pane.

+ When all of the Actions for a case have been evaluated, Composer sets the Service Response
DOM.

+ The final case in the Action model is always labeled Default. This case is generated
automatically and cannot be removed. Actions placed under Default are executed if and only if
the none of the other cases are matched. While you are not required to place actions under
Default, it is good programming practice to have at least some kind of fallback logic for the
Default case, even if it’s only a Log action or a Raise Error action.

+ The Request and Response document displays for Service Requests work similarly to the
displays for Requests (see “Request and Response Documents” on page 32).
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Managing Deployed Baan Services

36

Once a project containing Baan Services has been deployed (see “Deploying Your Project” in the Novell
exteNd Composer User s Guide), the Listener objects actively listen for messages each time you start
your server. To manually start and stop these services you need to use the exteNd Baan Service Console.
This browser-based console allows you to see the list of Baan Services, the status of each service (running
or not running), the running tally (Count) of messages received, other administrative information, and a
Start/Stop button.

> To display the exteNd Baan Services Console:
1 Make sure that your application server is running.

2 From the Windows Start menu, select Programs > Novell Extend 5.2 > Composer > Composer
Server Console. A dialog box for entering the application server administrator ID and password is

displayed.
3 Type your administrator ID and password, then select OK. The Composer Server Console page is
displayed.
4 Scroll down the About Products list on the left side of the page until you see the link titled
“baanservice”.
%) exteNd Composer Server Console - Mozilla Firefox I =]
File Edit ¥iew Go Bookmarks Tools Help m
L= = {l@ * fa [® repiiflocahostjextendComposer/Consale G |

exteNd Composer

E  EEAEEEEEEEEEEE Fovel

T21 Al
General Properties and Settings

TELNET

Wi Free Mermory: 27 Wb
Tandem Log Level: ,_5
uTs
- Apply Log Lewvel
baan
baanservice Cache Status
B Expressions Cached: 74
e ¥Path Nodes Cached: 0
jdeservice Functions/Code Tables Cached: 0
Camponent Types Cached: 4
bwsn Tatal Components Cached: q

Iwsnservice Clear Cache

orac

Cache Tuning
oracservice

Q Expression f ¥Path Caching: ®on © off

psit

Companent Cache Expiry: 7en
psftservice Total Component Cache Size: 250
shl Apply Cache Tuning
sbhersice o 20Nl e, 20802/ 1068 |
&P hittpsjflocalhost fexteNdComposer ProductAbout jsp?PRODUICT=oracservice: v

5 Select the “baanservice” link. A page is displayed that provides information (e.g., version, license
number, copyright) about the Connect. It also displays a Console button.

6 Select the Console button. The Baan Service console page is displayed. This page lists any Baan
Services that have been deployed.

7 To stop a Baan Service, select the appropriate Stop button (the button will then change to Start).

NOTE: If messages are being handled by a service at the time of the Stop command, there may
be some delay before the service actually exits. Select the Refresh button periodically until the
“Running” column of the console says No for the service.

> To undeploy a Baan Service:
1 Make sure that your application server is running.

2 From the Windows Start menu, select Programs > Novell Extend 5.2 > AppServer > Server
Management Console.

3 Login as an administrator (File > Login).
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4 Select the Deployment icon (_8|)from the toolbar.
5 Sclect Deployed Objects:

@ localhost:80 jb JHOI Tree Manage UR

Deployed Objed Configure deployed objects for a senrerl
4 a SilverMasters0

6 Expand the database containing the deployed objects that you want to manage:

Deployed Ohjects:
= a Silverhasters0

%‘ Express

é‘ exteMdComposzer_ear

é‘ Servicelistener_ear

7 Select the object that you want to undeploy.
8 Sclect the Undeploy button.

ECMAScript Extensions

See Appendix A to this guide for a list of ECMAScript extension methods that can be used with the Baan
Connect.
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ECMAScript Methods

The J2EE Connector framework of the exteNd Composer Connect for Baan implements a number of
ECMAScript extension methods that are available for use through the Expression Builder (which is

available in Function Actions and elsewhere). You will find the methods listed in the Functions/Methods
pane of the Expression Builder:

x|
WVariables: Functions Methocs: Operators:
[F-< > Input [+ Custom Scripts [+ Math
[} > Output [+ Document [+}-Relational
[ > _SystemFault [ ECMAScript [+}-Logical
[} <> Request [} Extended ECMAScript [*} String
[*}-<< > Response [*+-LDAP Script
[*}-<> PROJECT =} JDEdwards
[z} <> Repeat Ali (=} Adapter Interface Method
[+}-< > Node Aliases getAdapterType()
[=}-Java Connector Methods
getAdapterMetaData(String asType)
getConnectionMetaData(String asType)
[ validate || ok | cancel

ToolTip help is available for each method.

For more information about working with the Expression Builder, see “Custom Scripting and XPath
Logic in exteNd Composer” in the Novell exteNd Composer User s Guide.

Adapter Interface Methods

getAdapterType

This method calls the IGNVAdapterInterface.getAdapterType(), and returns the adapter type name (e.g.,
“baan”).

Syntax:
getAdapterType()
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Connection Interface Methods
The following CCI API metadata-wrapped methods are published through the Expression Builder.

getAdapterMetaData
This method wraps calls on the javax.resource.cci.ResourceAdapterMetaData class.

Syntax:
getAdapterMetaData(parameter)

Parameter Description
NAME Returns the name of the adapter (e.g., “iWay JCA adapter”).
EXECUTEWITHI Returns true if the implementation class for the Interaction interface

implements public Record execute method; otherwise the method
returns false.

EXECUTEWITHIO Returns true if the implementation class for the Interaction interface
implements public boolean execute method; otherwise the method
returns false.

VENDOR Returns the name of the vendor that has provided the resource adapter
(e.g., “iWay Software, Inc.”).

VERSION Returns the version of the resource adapter (e.g., “5.5”).

INTERACTIONSPECS Returns the fully-qualified name of the InteractionSpec type supported
by this resource adapter (e.g., “com.ibi.afjca.I[WAFInteractionSpec”).

SPECVERSION Returns a string representation of the version of the connector
architecture specification that is supported by the resource adapter
(e.g., “1.0").

LOCALTX Returns true if the resource adapter implements the LocalTransaction

interface and supports local transaction demarcation on the underlying
EIS (Enterprise Information System) instance through the
LocalTransaction interface.

getConnectionMetaData
This method wraps calls on the javax.resource.cci.ConnectionMetaData class.

Syntax:
getConnectionMetaData(parameter)

Parameter Description

EISPRODUCTNAME Returns the product name of the underlying EIS instance (e.g., “Baan”).

EISPRODUCTVERSION Returns product version of the underlying EIS instance.

USER Returns the user name for an active connection as known to the
underlying EIS instance.
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Additional Methods

The following ECMA-wrapped methods are not displayed by the Expression Builder user interface, but
you can use them in the Expression Builder by typing them directly into expressions.

getWarnings()

Returns line separated list of javax.resource.cci.ResourceWarning for the javax.resource.cci.Interaction.
clearWarnings()

Calls javax.resource.cci.Interaction.clearWarnings().
getLastError()

Returns last error, such as a javax.resource.ResourceException.
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